
DIGITAL VOICE
RECORDER

DS-2300
ONLINE

INSTRUCTIONS

Thank you for purchasing an Olympus
Digital Voice Recorder.

Please read these instructions for information
about using the product correctly and safely.

Keep the instructions handy for future reference.

To ensure successful recordings, we
recommend that you test the record function

and volume before use. EN
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Safe and Proper
Usage
Before using your new recorder, read this
manual carefully to ensure that you know
how to operate it safely and correctly.
Keep this manual in an easily accessible
location for future reference.

• The warning symbols indicate important safety
related information. To protect yourself and others
from personal injury or damage to property, it is
essential that you always read the warnings and
information provided.

General Precautions

� Do not leave the recorder in hot,
humid locations such as inside a
closed automobile under direct
sunlight or on the beach in the
summer.

� Do not store the recorder in places
exposed to excessive moisture or
dust.

� Do not use organic solvents such as
alcohol and lacquer thinner to clean
the unit.

� Do not place the recorder on top of
or near electric appliances such as
TVs or refrigerators.

� Avoid recording or playing back near
cellular phones or other wireless
equipment, as they may cause
interference and noise. If you
experience noise, move to another
place, or move the recorder further
away from such equipment.

� Avoid sand or dirt. These can cause
irreparable damage.

� Avoid strong vibrations or shocks.
� Do not disassemble, repair or modify

the unit yourself.

Convention Used In this Manual
• The word “card” is used to refer to the xD-

Picture Card.
• The word “DSS Player” is used to refer to

the DSS Player version 6 in Windows and
Apple Macintosh environment.

• The Notes at the bottom of a page are used
for additional information, exceptions, or
related events.

• Words in uppercase form such as PLAY or
REC are used to describe a function or
button on the recorder.
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Batteries

 Warning

• Batteries should never be exposed to
flame, heated, short-circuited or
disassembled.

• Do not attempt to recharge alkaline,
lithium or any other non-rechargeable
batteries.

• Never use any battery with a torn or
cracked outer cover.

• Keep batteries out of the reach of
children.

• If you notice anything unusual when
using this product such as abnormal
noise, heat, smoke, or a burning odor:
1 remove the batteries immediately

while being careful not to burn
yourself, and;

2 call your dealer or local Olympus
representative for service.

� Do not operate the unit while
operating a vehicle (such as a
bicycle, motorcycle, or go-cart).

� Keep the unit out of the reach of
children.

<Warning regarding data loss>
Recorded content in memory may be
destroyed or erased by operating
mistakes, unit malfunction, or during
repair work.
It is recommended to back up and save
important content to other media such as
a computer hard disk.
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This product is equipped with the following
features.

� Connect the USB connection cable to
enable high speed data transfer to a
computer. (� P.50)

� Recording and storing voice in DSS
format.

� Two recording modes, SP (Standard
Playback) mode or LP (Long Playback)
mode (� P.23).

� It has a large backlight full-dot display
(LCD display screen). (� P.39)
• The screen displays information about

recorded voice files and easily understood
operational messages.

� The five folders can hold 199 files each,
for the maximum of 995 recordings.
(� P.18)

� It has a built-in Variable Control Voice
Actuator (VCVA) function. (� P.24)

� You can insert or delete index marks.
(� P.32)
• If you insert index marks during recording or

playback, you will later be able to quickly find
the recording you want to hear.

� Comes with DSS Player software. (� P.42)
• If you transfer voice files recorded with the

recorder to a PC, you can easily play back,
organize, and edit the files. (� P.55)

• If you connect the recorder to a computer, you
can use it as a USB microphone or USB
speaker. (� P.63)

1 Getting Started

Main Features

M
ain

 F
eatu

res

The “DSS Player” can be
upgraded to “DSS Player Plus”,
which is equipped with enhanced
functionality (paid option). (�P.65)

Plus

*: In a quiet environment, it is necessary to set
this recorder to SP mode, and that the person
whose voice is registered in the speech
recognition software speak with the constant
tone of voice when recording.

The voice file recorded under the following
conditions is not suitable for character
conversion, since the software may have
difficulty in recognizing the voice.

— Meetings, discussions where voices of more
than one person can be recorded

— Conferences, lectures where the surrounding
noise can be recorded

� The “DSS Player” can be upgraded to a
“DSS Player Plus”, which is equipped with
a enhanced functionality (Option). (� P.65)
• If a commercial voice recognition software is

util ized, the recorded voice file can be
converted to characters automatically.*
(� P.67)

• In addition to the “DSS Player” functions,
joining and splitting of the files and configuring
the menu settings of this recorder, etc. can be
performed.
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IBM, PC/AT, and ViaVoice are the trademarks or
registered trademarks of International Business
Machines Corporation.

Microsoft, Windows and  Windows Media are
registered trademarks of Microsoft Corporation.

Apple, Macintosh, iMac, Mac, and PowerMac are
trademarks or registered trademarks of Apple
Computer, Inc.

Intel and Pentium are registered trademarks of Intel
Corporation.

CORTOLOGIC is a registered trademark of
Ruwisch & Kollegen GmbH.

Other product and brand names mentioned herein
may be the trademarks or registered trademarks
of their respective owners.

ScanSoft and Dragon NaturallySpeaking are the
trademarks or registered trademarks of ScanSoft, Inc.
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xD-Picture Card
The xD-Picture Card is a removable recording media.

Memory Size SP Mode LP Mode

16MB    2 hr. 30 min. 5 hr. 30 min.

32MB  5 hr. 10 min. 11 hr. 05 min.

64MB 10 hr. 25 min. 22 hr. 20 min.

128MB 20 hr. 55 min. 44 hr. 45 min.

256MB 42 hr. 00 min. 89 hr. 40 min.

512MB 84 hr. 05 min. 179 hr. 30 min.*2

Memory Sizes of Cards and Approximate Recording Times*1

1 Index area
You can write
down the card’s
contents.

Compatible Cards

The removable card can be used to store different
kind of data. Since the card has larger memory
capacity than a diskette, it can be used to transfer
data between different PCs. The recorder supports
cards with memory capacity between 16 to 512 MB. 2 Contact area

Comes into contact
with the recorder’s
signal read
contacts.

*1: Available recording time for one continuous file.
Available recording time may be shorter if many
short recordings are made.

*2: Total recording time of two files. The maximum
recording time per file is 99 hours.

..............................................................................................................................................................

Notes
• When initializing (formatting) a card, confirm that no necessary data is stored on the card

beforehand. Initialization completely erases the existing data on the card.
• Cards used in a recorder must be formatted in the same recorder first unless formatted with a

CAMEDIA series Olympus digital camera. Card may not perform as expected when formatted by a
different device.

• The card has a service life. When reaching the end of its life, writing or erasing data on the card will be
disabled. In this case, replace the card.

• If you use a PC card adapter compatible with the card to save or delete some data on the card, the
maximum recording time on the card may be decreased. To recover the original recording time, initialize/
format the card in the recorder.

• Olympus will not be held liable for any data corruption or loss due to misuse of the media card.
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1 EAR (Earphone) jack

2 MIC (Microphone) jack

3 Built-in microphone

4 NEW button

5 HOLD switch

6 REC (Record) button

7 REW (Rewind) button

8 FF (Fast Forward) button

9 INDEX button

0 FOLDER/MENU button

! Built-in speaker

@ STOP button

Identification of Parts
Id

en
tificatio

n
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# PLAY button

$ ERASE button

% DISPLAY button

^ Display (LCD panel)

& Record/Play indicator lamp

* POWER (ON/OFF) switch

( VOLUME (+) button

) VOLUME (–) button

- Card cover

= Card cover lock

q Battery cover

w PC (USB) terminal
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1 Battery indicator

2 Folder

3 Current file number

4 Total number of recorded files in the folder

5 Character Information display

6 Erase lock indicator

7 Microphone sensitivity display

8 VCVA (Variable Control Voice Actuator)

indicator

9 Record mode indicator
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Identification of Parts

Display (LCD Panel)
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Inserting Batteries
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sertin
g
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atteries

1 Lightly press down on the arrow and slide the
battery cover open.

2 Insert two AAA alkaline batteries, observing the
correct polarity.

3 Close the battery cover completely.

Replacing batteries

The battery indicator on the display changes as the batteries
lose power.

  ➜    ➜    ➜  

When  appears on the display, replace the batteries as
soon as possible.
When the batteries are too weak, the recorder shuts down
and “BATTERY LOW” appears on the display.

An optional Ni-MH Rechargeable Battery from Olympus
can be used for the recorder (� P.83).

....................................................................................................................................................
Notes
• Be sure to turn OFF the recorder before replacing the batteries. Removing the batteries while the recorder

is in use may corrupt the card. If you are recording into a file and the batteries run out, you will lose your
currently recorded file since the file header will not be written.  It is crucial to replace the batteries when
one hash mark in shown in the battery icon.

• Be sure to replace both batteries at the same time.
• Never mix old and new batteries, or batteries of different types and/or brands.
• If it takes longer than 1 minute to replace dead batteries, you may have to reset the time when you load

fresh batteries (� P.13).
• Remove the batteries if you are not going to use the recorder for an extended period of time.
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Turning ON the Recorder

With the battery in the recorder and the card inserted properly,
the recorder is ready to work.
While the power switch on the back of the recorder is in the
OFF position, none of the buttons or switch on the recorder
will be active. Slide the power switch to the ON position to
activate the recorder.

Power Save Mode

When the recorder is ON but not in use for 10 minutes, it will switch to power save mode
automatically. To reactivate the recorder again, press any of the buttons on the recorder.
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Setting the correct time and date on the recorder is very important since every file recorded on
the recorder will have the date and time information as part of the file header. This will simplify
the file management aspects later on.

The hour indicator will flash automatically when you load batteries before using the
recorder for the first time, or after the recorder hasn’t been used for a long time.
Proceed from step 1.

Setting Time/Date (TIME&DATE)
S

ettin
g

 Tim
e/D

ate (T
IM

E
&

D
A

T
E

)

REC button
(Accepts a choice and moves
on to the next item)

FF/REW
button
(Alters a choice)

DISPLAY
button
(Switching the
data displayed.)

1 Set the hour.
1 Press the FF button or REW button to set

the hour.
2 Press the REC button to accept the hour.

• You can choose between 12 and 24 hour
display by pressing the DISPLAY button
while setting the hour and minute.

Example: 5:45 P.M.
5:45 PM ←→ 17:45

(Initial setting)

2 Set the minute.
1 Press the FF button or REW button to set

the minute.
2 Press the REC button to accept the minute.

3 Set the year.
1 Press the FF button or REW button to set

the year.
2 Press the REC button to accept the year.
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.............................................................................................................................................................

Notes
• If you press the STOP button during the setup operation, the recorder will save the items that were set to

that point.
• You can set the time and date from your PC using DSS Player software (� P.42).

4 Set the month.
1 Press the FF button or REW button to set

the month.
2 Press the REC button to accept the month.

5 Set the date.
1 Press the FF button or REW button to set

the date.
2 Press the REC button to accept the date.

Setting Time/Date (TIME&DATE)

REC button
(Accepts a choice and moves
on to the next item)

FF/REW
button
(Alters a choice)

DISPLAY
button
(Switching the
data displayed.)

• You can choose the order of the year, month,
day by pressing the DISPLAY button while
setting them.

Example: March 14, 2005

3M 14D 2005Y
 (Initial setting)

↓
14D 3M 2005Y

↓
2005Y 3M 14D
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1Changing the Time/Date

3

1,5

2,4

1 Press and hold the FOLDER/
MENU button for 1 second or
longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “SUB MENU”, and press
the REC button.
The sub menu appears (� P.41).

3 Press the FF or REW button until
“TIME&DATE” flashes on the
display.

4 Press the REC button.
Time/Date screen appears. The hour
indicator flashes, indicating the start of
the Time/Date setup process.
Follow the same steps starting at step 1
in “Setting Time/Date” (� P.13).

5 Press the FOLDER/MENU button
to close the menu.

S
ettin

g
 Tim

e/D
ate (T

IM
E
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D
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T

E
)

SUB MENU

REC MODEREC MODE
MIC SENSE

VCVA

REC MODE

SUB MENUSUB MENU
VCVA

EXIT
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Inserting and Ejecting a Card

Inserting a Card

1 Slide the card cover lock in the direction indicated
by the arrow.
The card cover is unlocked and the message “CARD COVER IS
OPEN” appears on the display. When this message appears, the
power is switched off automatically.

2 Face the card the correct way and insert it into
the card slot as shown in the diagram.
• Insert the card keeping it straight.
• The card stops with a click when it is inserted all the way.
• Inserting the card the wrong way or at an angle could

damage the contact area or cause the card to jam.
• If the card is not inserted all the way, data may not be

written to the card.

3 Close the card cover securely.

1

2

3

In
sertin

g
 an

d
 E

jectin
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 a C
ard

Card inserted fully into the slot
The message “PLEASE WAIT” on the display flashes for
seconds.

Card not inserted fully into the slot
When the card cover is closed, the message “INSERT CARD”
on the display flashes for a few seconds. Pressing any button
will sound beeps* and flash the message “INSERT CARD”
again.

* When the system sounds are enabled.

..............................................................................................................................................................

Notes
• If an unformatted card is inserted, the recorder automatically displays the menu to menu format option

(� P.35).
• Never use any card in the recorder unless it has been formatted on this unit or on a CAMEDIA series Olympus

digital camera (� P.35).
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Ejecting a Card

1 Make sure the recorder is STOP mode.

2 Slide the card cover lock in the direction
indicated by the arrow.
The card cover is unlocked and the message “CARD
COVER IS OPEN” appears on the display. When this
message appears, the power is switched off automatically.

3 Push the card inward to unlock it, and let it eject
partially.
The card is visibly out of the slot and can be removed safely.

4 Hold the card straight and pull it out.

In
sertin

g
 an

d
 E

jectin
g

 a C
ard

..............................................................................................................................................................

Note
Releasing your finger quickly after pushing the card inward may cause it to eject forcefully out of the slot.
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Recording

The recorder has five folders, A, B, C, D, E  and you can select folder by pressing the
FOLDER/MENU button. These five folders can be selectively used to distinguish the kind of
recording; for example, Folder A might be used to store private information, while Folder B
might be dedicated to holding business information. You can use your DSS player to change a
folder name (� P.62). Up to 199 messages can be recorded per folder.
All recordings made in any of the folders will be in Digital Speech Standard (DSS) format. By
default, the RECORD function is configured to record at the current position (overwrite). However,
that can be changed to any of the following settings:
• Append: Appends the recording to the end of the current file.
• Insert: Inserts the recording at the current position in the file.
• Overwrite: Overwrites the recording starting at the current position in the file.

R
eco

rd
in

g

2 Basic Operations

1 Press the FOLDER/MENU button
to choose a folder.
The folder name is displayed for 2
seconds.

2 Press the NEW button to create
a new file.
a Current recording mode
b New file number
c Selected Author ID

3 Press the REC button to start
recording.
The record/play indicator lamp glows red.
Aim the microphone at the sound source.
d Current recording time
e Remaining recording time

4H33M12S
REMA I N :

NEW  F I LE
AUTHOR  A 

a
b

c

1

3
2

Built-in
microphone

New Recording
Create a new file to record in.

AUTHOR  A 
00M05S

4H33M07S
d
e
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Pause

Press the REC button while recording.

➥ “REC PAUSE” will flash on the display.
• The recorder stops when it has been left paused for 10 minutes or

longer.

Resume Recording

Press the REC button again.

➥ Recording will resume at the point of interruption.

R
eco

rd
in

g

4 Press the STOP button to stop
recording.
If you want to append additional recordings
to the same file, press the REC button
again.

4

Review Recording

Press the REW button when recording, and release it when you want to start playback.
The recorder plays up to the end of file, then stops.
You can overwrite or append additional recordings in the same file from that point.

.............................................................................................................................................................

Notes
• A beep will sound when remaining recording time reaches 60 seconds, 30 seconds, and 10 seconds while

recording.
• “MEMORY FULL” or “FOLDER FULL” will be displayed when the memory or folder capacity is full. Delete

any unnecessary files before recording any further (� P.29) or transfer voice files to your computer using
DSS Player Software (� P.42).

• You cannot select a different recording mode (SP or LP) than that of the original file when appending
recording (� P.23).

• While recording, pressing the PLAY button stops recording and plays back the current file.
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Recording

R
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Overwrite Recording
You can overwrite a previously recorded file from any point within the file.
Note that the overwritten recordings will be erased.

1 Press the FOLDER/MENU button
to choose a folder.
The folder name is displayed for 2
seconds.

2 Press the FF or REW button to
choose the file into which you want
to overwrite.

3 Press the PLAY button to play the
file.
a Current playback time
b Total recording time of the file being

played

4 Press the STOP button where you
want to start overwriting.

5 Press the REC button to start
overwriting.
The record/play indicator lamp glows red.

6 Press the STOP button to stop
overwriting.

AUTHOR A
00M00S

LENGTH :
27M58S

2

1

3
4,6

5

14M00S

AUTHOR  A 
10M25S

AUTHOR A
00M05S

LENGTH :
27M58S

a

b

.............................................................................................................................................................

Note
You cannot select a different recording mode (SP, LP) than that of the original file before overwrite recording.
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.............................................................................................................................................................

Notes
• The recording time and date of the file is updated to the time and date of the inserted recording.
• You cannot select a different recording mode (SP, LP) than that of the original file before inserting.

6 Press the STOP button to stop
inserting additional recording.

Insert Recording
Additional recording can be inserted into previously recorded file.

1 Press the FOLDER/MENU button
to choose a folder.
The folder name is displayed for 2
seconds.

2 Press the FF or REW button to
choose the file into which you want
to insert additional recordings.

3 Press the PLAY button to start
playback.

4 While playing the file, press the
FOLDER/MENU button to insert
an additional recording.
“INSERT ?” appears on the display.

5 Press the REC button to start
inserting additional recording.
The record/play indicator lamp glows red.
“INSERT REC” and the remaining
recording time will alternate on the display.

AUTHOR A
00M00S

LENGTH :
27M58S

2

1,4

3
5

6

AUTHOR   A
00M10S

02M25S
INSERT  ?

R
eco

rd
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g

AUTHOR   A
00M12S

I NSERT  REC

AUTHOR  A 
00M11S

4H33M06S
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Microphone Sensitivity (MIC SENSE)
Microphone sensitivity is adjustable to meet recording needs.

M
icro

p
h
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n
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1 Press and hold the FOLDER/
MENU button for 1 second or
longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “MIC SENSE” flashes on
the display.

3 Press the REC button.
The microphone sensitivity setup
process begins.

4 Press the FF or REW button to
choose between “CONF.” and
“DICT.”.
CONF.: High-sensitivity mode that

records sounds in all directions.
DICT.: Low-sensitivity mode suited for

dictation.

5 Press the REC button to complete
the setup screen.

6 Press the FOLDER/MENU button
to close the menu.

SUB MENU

MIC SENSEMIC SENSE
EXIT

REC MODE

CONF.CONF.
DICT.

MIC SENSEMIC SENSE

.............................................................................................................................................................

Note
If you want to record clear or noise-free dictation, select DICT mode and place the microphone 5 cm to 10
cm (2 to 4 inches) from the source.
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Recording Modes (REC MODE)
The recording mode can choose between SP (standard recording) and LP (long-term recording).

R
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1 Press and hold the FOLDER/
MENU button for 1 second or
longer.
“REC MODE” will be displayed on the
screen (� P.41).

2 Press the REC button.
The recording mode setup process
begins.

3 Press the FF or REW button to
choose between “SP” and “LP”.

4 Press the REC  button to complete
the setup screen.

5 Press the FOLDER/MENU button
to close the menu.

EXIT

REC MODE
MIC SENSE

VCVA

SP
LP

REC MODEREC MODE

.............................................................................................................................................................

Note
Choose SP mode for recording meetings or lectures with crisp clarity.
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Using the Variable Control Voice Actuator (VCVA)
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1 Press and hold the FOLDER/
MENU button for 1 second or
longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “VCVA” flashes on the
display.

3 Press the REC button.
The VCVA setup process begins.

4 Press the FF or REW button to
choose between “ON” and “OFF”.
ON: Will start recording in VCVA mode.
OFF: Will resume recording in normal

mode.

5 Press the REC button to complete
the setup screen.

6 Press the FOLDER/MENU button
to close the menu.
When “ON” is selected, a VCVA
indication will be displayed on the
screen.

ONON
OFF

VCVA

MIC SENSE

VCVA
REC MODE

SUB MENU

When the microphone senses that sounds have reached a preset threshold volume level, the
built-in Variable Control Voice Actuator (VCVA) starts recording automatically, and stops when
the volume drops below the threshold level.
The VCVA feature extends recording time and conserves memory by turning off recording
during silent periods. This helps make the playback, with no lulls or dead space, more efficient
and convenient.
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....................................................................................................................................................
Notes
• The start/stop actuation level also varies depending on the selected microphone sensitivity mode (� P.22).
• If the starting level is not adjusted within 2 seconds, the display will return to the previous.
• To ensure successful recordings, prior testing and adjustment of the start/stop actuation level is

recommended.

7 Press the REC button to start
recording.
When the sound volume is lower than
the preset threshold sound level,
recording automatically stops after 1 sec
approximately,  and “STANDBY” flashes
on the display. The record/play indicator
lamp glows when recording starts and
flashes when recording pauses.

2

1

Adjust the start/stop actuation level

1 Press the FOLDER/MENU
button during recording.
The VCVA level screen displayed.

2 Press the FF or REW button to
adjust the pause sound level.

The VCVA level can be set to any of 15
different values. The higher the value, the
more sensitive the recorder to sounds. At
the highest value, even the faintest sound
will activate recording.
The VCVA pause sound level can be
adjusted according to the ambient
(background) noise.
a Level meter (varies according to the sound

volume being recorded)
b Start level (moves to the right/left according

to the set level)

AUTHOR   A
1H25M01S

STANDBY

AUTHOR   A
1H25M01S

VCVA LEVEL 05a
b
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2 Connect the earphone to the EAR jack on
the recorder.
After recording is started, you can hear the sound
being recorded through the earphone.
If the earphone is connected, no sound will come
from the speaker.
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Recording Monitor
If you start recording after inserting the earphone into the EAR jack on the recorder, you can
hear the sound being recorded. The sound volume on the recording monitor can be adjusted
by pressing the VOLUME (+) or VOLUME (–) button.

VOLUME (+)/(–)
button

.............................................................................................................................................................

Notes
• Recording level cannot be controlled using the volume button.
• When using the earphones, do NOT set the volume too high. Listening at very high volume may lead to

hearing loss.
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2
1 Press the FOLDER/MENU button

to choose folder.

2 Press the FF or REW button to
choose the file that you want to
play.

3 Press the PLAY button to start
playback.
The record/play indicator lamp glows
green.
a Current playback time
b Total recording time of the file being

played

4 Press the VOLUME (+) or
VOLUME (–) button to select the
proper sound volume.
The display shows the volume level. You
can choose between 0 to 30.

5 Press the STOP button at any
point you want to stop the
playback.
Resume playback by pressing PLAY
button again.

2

15
3 AUTHOR A

00M00S
LENGTH :

27M58S

AUTHOR A
00M05S

LENGTH :
27M58S

a

b

Playing
P

layin
g

4
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• If you press the FF button once while fast-forwarding or twice while stopped, the recorder will stop at the
end of the file (F.SKIP).

• If you press the REW button once while rewinding or twice while stopped, the recorder will stop at the
beginning of the file (B.SKIP). If the REW button is pressed within 2 seconds, the recorder skips to the
beginning of the previous file.

Playback
functions
Fast
Forward
(FF)

Rewind
(REW)

Cue
(CUE)

Review
(REV)

Operation

Press the FF button once while stopped.

Press the REW button once while stopped.

Hold the FF button while stopped or playing a file.

Hold the REW button while stopped or playing a file.

How to Cancel

Press the PLAY button.
➥ The recorder starts the operation of

the set position.

Release the FF button.

Release the REW button.

Playback functions

Playing



29

2

2

1

3,4

Erasing

Erasing One File

A selected file can be erased from a folder.

1 Press the FOLDER/MENU button
to choose a folder.

2 Press the FF or REW button to
choose the file you want to erase.

3 Press the ERASE button.
“FILE ERASE ?” flashes on the display
for approximately 8 seconds.

FOLDER   A

F I LE
ERASE  ?

E
rasin

g

FOLDER   A

ERASE DONE  

{

4 Press the ERASE button once
more while “FILE ERASE ?” is
flashing.
The display changes to “FILE ERASE!”
and erasing will start.

“ERASE DONE” is displayed when the file
is erased. File numbers will be reassigned
automatically.

FOLDER   A

F I LE
  ERASE  !

....................................................................................................................................................
Notes
• An erased file cannot be restored.
• The file set to erase lock will not be erased (� P.31).
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1

2,3

Erase All Files in a Folder

All files in a folder can be erased simultaneously, except for locked files (� P.31).

1 Press the FOLDER/MENU button
to choose the folder you want to
erase all files.

2 Press the ERASE button for 3
seconds or longer.
“ALL ERASE ?” flashes on the display
for approximately 8 seconds.

3 Press the ERASE button once
more while “ALL ERASE ?” is
flashing.
The display changes to “ALL ERASE!”
and erasing will start.

“ERASE DONE” is displayed when the files
are erased. Locked files are reassigned file
numbers in ascending order.

FOLDER   A

 ALL ERASE ?

FOLDER   A

ERASE   DONE

{

FOLDER   A

 ALL ERASE !

....................................................................................................................................................
Notes
• An erased file cannot be restored.
• The file set to erase lock will not be erased (� P.31).
• Completion of erasing may take 10 seconds. Never do anything during this period because data may be

corrupted. Battery removal setting/removal are not permissible, whether or not the battery is set in the
recorder.

E
rasin

g

Erasing
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3 Other Functions

3,5

1,7

2,4,6

L
o
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1 Select the file you want to LOCK,
press and hold the FOLDER/MENU
button for 1 second or longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “SUB MENU”, and press
the REC button.
The sub menu appears (� P.41).

3 Press the FF or REW button until
“LOCK” flashes on the display.

4 Press the REC button.
The file locking setup process begins.

FORMAT

LOCKLOCK
BEEP

SUB MENUSUB MENU

Locking Files (LOCK)
Locking a file keeps important data from being accidentally erased.
Locked files are not erased when you choose to erase all files from a folder (� P.29).
Locked files are never erased except when the card is formatted (� P.35).

REC MODE

SUB MENUSUB MENU
VCVA

EXIT

5 Press the FF or REW button to
choose between “ON” and “OFF”.
ON: Locks the file and prevents it from

being edited or erased.
OFF: Unlocks the file and allows it to be

edited or erased.
a Erase lock indicator

6 Press the REC button to complete
the setup screen.

7 Press the FOLDER/MENU  button
to close the menu.

ON
OFF

FOLDER   A
a
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1

Index Marks

In
d
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arks

Setting an Index Mark

1 Press the INDEX button during
recording or playback to set an
index mark.
An index number appears on the display.

Locating an Index Mark

2 Hold the FF or REW button while
playing a file.
The recorder stops for 1 second when it
reaches the index mark.

Clearing an Index Mark

3 Locate the index mark you want
to clear.

4 Press the ERASE button while the
index number appears for
approximately 2 seconds on the
display.
The index mark is erased.

Index marks can be placed in a file during recording or playback to provide and quick and easy
way of keeping track of important sections in the file.

AUTHOR  A
12M05S

I NDEX  08
CLEAR

AUTHOR  A
12M05S

I NDEX  08
SET

....................................................................................................................................................
Notes
• Up to 16 index marks can be set in a file. Attempting to set more index marks will cause “INDEX FULL” to

appear on the display.
• Index marks cannot be set or cleared in a locked file (� P.31).
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AUTHOR  A
00M00S

LENGTH :
2H27M58S

AUTHOR  A
00M00S

REC   DATE :
3M16D2005Y

AUTHOR  A
00M00S

REC   TIME :
3M16D   12:56 A

M

AUTHOR  A
00M00S

COMMENT :_ _ _ _

AUTHOR  A
00M00S

REMAIN :
1H50M12S

AUTHOR  A
TIME&DATE :

3M16D2005Y
      12:00AM

{
{

{
{

{

{

1

LCD Display Information
The LCD screen on the recorder can display 6 different format of information by pressing the
DISPLAY button. This help review and confirm different recorder settings and file information.

L
C

D
 D
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lay In
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1 File length
Shows how long a file is.

2 Time stamp
Shows the year, month, and
date that the fi le was
recorded.

3 Time stamp
Shows the time that the file
was recorded.

6 Current time and date
Shows the current time and
date. (During playback, the
“TIME & DATE” or the
counter appears.)

5 Memory remaining
Shows remaining recording
time.

4 File comment*
Shows comment added to
a fi le. (If there is no
comment, “----” will appear.)

* If a comment contains many characters, it will
scroll horizontally to display the complete
comment.

1 Press the DISPLAY button.
The LCD display views will switch every time the DISPLAY
button is pressed.

While in stop or playback mode
When pressing Display, the recorder will cycle through 1 to
6. If there is no file, 5 and 6 will display alternately.
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AUTHOR  A
25M01S

2H33M25S

AUTHOR  A

E F

25M01S
2H33M25S

1 Recording level meter
Displays the sound input level
graphically and the remaining
time available for recording in
countdown mode.

2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode and countdown mode.

While in record mode

1 VCVA recording level
meter
Displays the sound input level
graphically and the remaining
time available for recording in
countdown mode.
(“STANDBY” appears if the VCVA
actuation level isn’t reached.)

2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode and countdown mode.AUTHOR  A

25M01S
2H33M25S

AUTHOR  A

E F

25M01S
2H33M25S

While recording in VCVA mode

AUTHOR   ID
10M25S
14M00S

AUTHOR   ID
10M25S
14M00S

E F

1 Recording level meter
Displays the sound input level
graphically, the current time
and the length of the file.

2 Remaining memory bars
Displays the remaining time
available for recording in bar
mode, and the current time
and length of the file.

While in Overwrite Record Mode

1 Recording level meter
Displays flashing “INSERT
REC”, the sound input level
graphically, and the current
recording time.

2 Remaining memory bars
Displays flashing “INSERT
REC”, the remaining time
available for recording in bar
mode, and the current
recording time.

AUTHOR   ID
1H25M01S

INSERT  REC

AUTHOR  A
1H25M01S

I NSERT  REC
E F

While in Insert Record Mode

LCD Display Information
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31 Press and hold the FOLDER/
MENU button for 1 second or
longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “SUB MENU”, and press
the REC button.
The sub menu appears (� P.41).

3 Press the FF or REW button to
until “FORMAT” flashes on the
display.

4 Press the REC button.
The formatting process is selected.

5 Press the FF button to choose
“START”.

6 Press the REC button.
“DATA WILL BE CLEARED” appears for
approximately 2 seconds.

FORMAT
EX I T
CONTRAST

CANCEL
START

DATA  W I LL
BE  CLEARED

3
5
1

2,4,6

Formatting the Card (FORMAT)
F

o
rm

attin
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 th
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 (F
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T
)

Cards that have been used on non-Olympus devices, or cards that are not recognized by the
recorder, must be formatted before they can be used with the recorder. The Olympus
xD-Picture Card delivered with the recorder is preformatted and ready for use.
To familiarize yourself with the formatting process, read the steps below.

REC MODE

SUB MENUSUB MENU
VCVA

EXIT
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7 Press the FF button again to
choose “START”.

8 Press the REC button again.
Formatting begins and an indicator
flashes on the display.

“FORMAT DONE” displays when formatting
ends.

{

FORMAT!

FORMAT
DONE

SURE?
CANCEL
START

....................................................................................................................................................
Notes
• The time required to format cards differs depending on the capacity of cards. For example, formatting may

take about 1 minute for 512 MB card. Do not interrupt the formatting process by opening the card cover or
the battery cover. Doing so will damage the data or card.

• When the card is formatted, all the stored data, including locked files, are erased.
• If an unformatted card is inserted, the recorder automatically displays the format option in the menu.

Formatting the Card (FORMAT)
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Setting the HOLD switch to the HOLD
position.
If you set the recorder to HOLD status by sliding
the HOLD switch in the direction of the arrow, the
current conditions will be preserved, and all buttons
and switches except the HOLD switch will be
disabled. This feature is useful when the recorder
has to be carried in a bag or pocket.
Remember to reset the HOLD switch when
using the recorder.

....................................................................................................................................................
Notes
• The display will flash if the switch is moved to hold in the stop status. At this time, if any button is pressed

the clock display will flash for about 2 seconds, but will not operate.
• If the switch is moved to hold during playback (or recording), the playback (recording) status will stay and

cannot be operated.
(When playback has ended and the recording has ended due the remaining memory being used up, it will
be in the stop state.)
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1,7

2,4,6

LCD Contrast Adjustment (CONTRAST)
If you find it difficult to read the display information due to lighting, temperature, or other
conditions, you can adjust the contrast using this function to easily see the LCD display (display
contrast).
Display contrast can be adjusted in 12 levels.

L
C
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1 Press and hold the FOLDER/
MENU button for 1 second or
longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “SUB MENU”, and press
the REC button.
The sub menu appears (� P.41).

3 Press the FF or REW button until
“CONTRAST” flashes on the
display.

4 Press the REC button.
The LCD display contrast setup process
begins.

5 Press the FF or REW button to set
the contrast level.
You can adjust the LCD display contrast
level from 1 to 12.
(Initial setting ......6)

6 Press the REC button to complete
the setup screen.

7 Press the FOLDER/MENU button
to close the menu.

BACKLIGHT

EXIT
CONTRASTCONTRAST

SUB MENUSUB MENU

REC MODE

SUB MENUSUB MENU
VCVA

EXIT
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3,5

1,7

2,4,6

Backlight (BACKLIGHT)
The recorder display backlight is ON by default. The display will lit for about 15 seconds when
a button on the recorder is pressed. The backlight feature can be turned off from the menu.

B
acklig

h
t (B

A
C

K
L
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)

1 Press and hold the FOLDER/
MENU button for 1 second or
longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “SUB MENU”, and press
the REC button.
The sub menu appears (� P.41).

3 Press the FF or REW button until
“BACKLIGHT” flashes on the
display.

4 Press the REC button.
The backlight setup process begins.

5 Press the FF or REW button to
choose between “ON” and “OFF”.
ON: Backlight is enabled.
OFF: Backlight is disabled.

6 Press the REC button to complete
the setup screen.

7 Press the FOLDER/MENU button
to close the menu.

TIME&DATE

CONTRAST
BACKLIGHTBACKLIGHT

SUB MENUSUB MENU

ONON
OFF

BACKLIGHTBACKLIGHT

REC MODE

SUB MENUSUB MENU
VCVA

EXIT
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1,7

2,4,6

System Sounds (BEEP)
The recorder beeps to alert you to button operations or warn you of errors. System sounds may
be turned off.

S
ystem
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o
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s (B

E
E

P
)

1 Press and hold the FOLDER/
MENU button for 1 second or
longer.
The menu appears (� P.41).

2 Press the FF or REW button to
choose “SUB MENU”, and press
the REC button.
The sub menu appears (� P.41).

3 Press the FF or REW button until
“BEEP” flashes on the display.

4 Press the REC button.
The system sound setup process begins.

5 Press the FF or REW button to
choose between “ON” and “OFF”.
ON: System sounds are enabled.
OFF: System sounds are disabled.

6 Press the REC button to complete
the setup screen.

7 Press the FOLDER/MENU button
to close the menu.

FORMAT

LOCK
BEEP

SUB MENUSUB MENU

ONON
OFF

BEEP

REC MODE

SUB MENUSUB MENU
VCVA

EXIT
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REC MODE

MIC SENSE

EXIT

SUB MENU

VCVA

LOCK

BEEP

FORMAT

EXIT

BACKLIGHT

TIME&DATE

CONTRAST

Select SP or LP mode (� P.23).

Notes
• If you press the STOP button or FOLDER/MENU button during a menu setup operation, the recorder will

stop and apply the items that were set to that point.
• The recorder will stop if you leave it idle for 3 minutes during a menu setup operation, when a selected item is

not applied.
• You can set the time and date on the recorder from your PC using DSS Player software (� P.42).

Time/Date setting. Hour, minute, year, month
and day (� P.13).

Recorder formatting (� P.35).

LCD contrast adjustment. Select the level
from 1 to 12 (� P.38).

System sounds setting. Select ON (enabled)
or OFF (disabled) (� P.40).

Backlight setting. Select ON (enabled) or
OFF (disabled) (� P.39).

Press and hold the FOLDER/MENU button for 1 second or longer.

Press the FF
button or REW
button.

VCVA setting. Select ON (enabled) or OFF
(disabled) (� P.24).

Microphone sensitivity setting. Select
between CONF (high-sensitivity mode) or
DICT (low-sensitivity mode) (� P.22).

Press the
REC button.

Returns to the MENU.

Exit MENU and return to STOP mode.

Locking files setting. Select ON (locked) or
OFF (unlocked) (� P.31).

Switches to the SUB MENU.

MENU

SUB MENU

M
en

u
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ettin
g
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eth

o
d

Menu Setting Method
Each item of the menu list can be set by the following method.



42

4

The DSS Player Software can be used to do the following:
• Playback voice files on your PC and on the recorder when connected via USB. Download

files from the recorder to the PC or upload files from the PC to the recorder.
• If an upgrade (Option) to DSS Player Plus is executed, various additional functions can be

utilized (�P.65).

Precautions on using the recorder connected to a PC

4           Preparation Before Using DSS Player

Using DSS Player Software
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� When you are downloading a file from
the recorder or uploading a file to the
recorder, do not remove the USB cable
even if the screen is indicating you can.
Data is still being transferred while the
record/play indicator lamp is blinking.
When removing the USB  cable, be sure
to follow the description in �P.51. If the
USB cable is removed before the drive
is stopped, data may not be
successfully transferred.

� On a PC, do not format the drive of the
recorder. Initialization is not successfully
achieved on a PC. For initialization, follow
the instructions in the menu screen of
the recorder (� P.41).

� Folder (directory) names displayed by
file management tools such as Explorer
attached to Microsoft Windows and
Finder attached to Mac OS are different
from the folder names settable with the
recorder or DSS player.

� If folders or files stored on the recorder
are moved or renamed by using a file
management tool such as Explorer or
Finder, the order of files may be
changed or files may become
unrecognizable.

� Data can be written or uploaded to the
recorder even though the attribute of
the recorder drive is shown as Read-
only by the operating system of the PC.

� As the noise may cause adverse effects
on electronic devices nearby the
recorder, unplug the earphone when
you connect the recorder to a PC.
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Windows Macintosh

Operating Environment

Basic Operating Environment of DSS Player

O
p

eratin
g

 E
n

viro
n

m
en

t

IBM PC/AT compatible PC

Microsoft Windows Me/ 2000
Professional/XP
Professional,Home Edition

Intel Pentium II class 333
MHz processor or more
(Processor 500 MHz or faster
is recommended)
128MB or more (256MB or
more is recommended)

50MB or more

2x or faster CD-ROM, CD-R,
CD-RW, DVD-ROM drive

Creative Labs Sound Blaster
16 or 100% compatible
sound card
Microsoft Internet Explorer
4.01 SP2 or later

800 x 600 pixels or more, 256
colors or more

One free port
Earphone output or speakers

• The mouse or similar to a
pointing device.

• Environment where the
Internet can be utilized.

PC:

Operating
System:

CPU:

RAM:

Hard drive
space:

Drive:

Sound card:

Browser:

Display:

USB port:
Audio I/O
terminals:

Others:

Power Mac G3 233 MHz
class processor or faster

iMac/ iBook/ eMac/ Power
Mac/ PowerBook
(The computer must support
a standard USB port)
(Processor 500 MHz or faster
is recommended)

Mac OS 10.1/10.2/10.3

128MB or more (256MB or
more is recommended)

50 MB or more

2x or faster CD-ROM, CD-R,
CD-RW, DVD-ROM drive

800 x 600 pixels or more, 256
colors or more
One free port

Earphone output or speakers

PC:

Operating
System:
RAM:

Hard drive
space:

Drive:

Display:

USB port:

Audio I/O
terminals:
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Windows

1 Insert DSS Player into the CD-ROM
drive.
The installation program will start
automatically. Once the program starts,
jump to step 4. If it does not, follow the
procedures in steps 2 and 3.

2 Click the [start] button and select
[Run].

3 Enter “D:\setup.exe” in the [Open]
field and click [OK] .
This is assuming the CD-ROM drive is D.

Before you connect the recorder to your PC and use it, you must first install the DSS player
software from the included Software CD.

Applications included with “DSS Player”
• DSS Player: Recorded voice files can be downloaded to the PC for complete file management and playback

solution.

• Acrobat Reader is installed on your PC. It is required to view the accompanying manual in PDF format.

Be sure to confirm the following before installation:
• Exit all running applications.

• Eject the floppy disk if you are using one.

• If you are running Windows2000/XP or Mac OS X on the network, you need to log on as an Administrator.

Installing Software
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4 The installation Language
Selection dialog box opens.
Click the desired language to select it.
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Installing the Device Driver

11 Connect the recorder to your PC,
referring to “Connection to Your
PC” (� P.50).
When you connect the recorder to your
PC for the first time after installing DSS
Player, the recorder ’s driver will be
installed automatically. If the driver is
installed properly, DSS Player will start
automatically.
(For details about operation for DSS
Player see pages from P.52)

Installing DSS Player

5 Register user information.
Enter your name, company name and
serial number. For the serial number,
see the label attached to the CD-ROM
package provided with DSS Player.
When entered, click [Next]. When the
confirmation dialog appears, click
[Yes].

6 Confirm your acceptance of
the terms of the Licensing
Agreement.
You must accept the terms of the
Licensing Agreement to install DSS
Player. If you accept them, click [Yes].

7 Select where to install DSS
Player.
This lets you specify the folder in which
to install DSS Player. Click [Browse] to
find the desired installation folder. To
accept the default folder, click [Next].
Note
If the installation folder does not exist, a
confirmation dialog box opens to get your
permission to create a folder for this
purpose. Click [Yes].

  8 Select a program menu folder.
You may change the program menu folder
to another one, such as [Start Up]. To
accept the default folder, click [Next].

9 Authorizing the start of file
copying.
Confirm all “Current Settings”. To accept
them, click [Next].
Note
To change the program menu folder or
installation folder, click [Back].

10 Copy files.
Wait until DSS Player is installed on
your PC, then click [Finish].
The screen returns to the opening
screen automatically.
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Macintosh

7 Completing setup.
Installation has finished. Click [Quit].

8 Register user information.
To use the DSS Player, it is necessary to
register the user information at the time
of initial startup.
Open the [DSS Player] folder created at
installation, and the user’s registration
screen will be displayed, if the  is
double clicked. Please input your name,
company name, and serial number.
Please see the seal attached to the CD-
ROM package included with the DSS
Player, for the serial number. After the
input has ended, click [OK] to complete
the registration.
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1 Insert DSS Player into the CD-ROM
drive.

2 Double-click CD icon.
Double-click the desired language to
select it.

3 Double-click the following icon.

4 Click [Continue] when the  DSS
Player opening screen appears.

5 Confirm your acceptance of the
terms of the Licensing Agreement.
You must accept the terms of the
Licensing Agreement to install DSS
Player. If you accept them, click [Agree].

6 Select where to install DSS Player.
This lets you specify the folder in which
to install DSS Player. To accept the default
folder, click [Choose].
Installing DSS Player.

Installing Software
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Uninstalling Software

1 Exit DSS Player.

2 Select [Control Panel] from [start] menu.

3 Click [Add/Remove programs] in the control panel window.

4 A list of applications that have been installed is displayed.
Select the software you would like to uninstall/remove.

5 Click [Change/Remove].

6 Confirmation of Deleting the program.
Click the [OK] button to start uninstalling.
An additional message may appear, if so, read it carefully and follow the instructions given.

7 When the [Maintenance Complete] screen is displayed, click [Finish] to
complete uninstalling.
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To uninstall any of the software component of the DSS player software installed on your PC,
follow the steps below.

Windows

....................................................................................................................................................

Note
The voice files you made are stored in the [MESSAGE] folder. If you don’t need them, delete them. You can
confirm the location of the [MESSAGE] folder by clicking [Options] in the [Tools] menu before uninstalling.
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Macintosh

1 Exit DSS Player.

2 Delete the Preferences File.
Delete the [DSS Preference] file in the following location.
Macintosh HD : Users : Library : Preferences

3 Delete the Executable File.
Delete the [DSS Player] file in the location where you installed the file.

4 Delete the Help File.
Delete the [DSS Player Help] file in the following location.
System Folder : Help
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....................................................................................................................................................

Note
The voice files you made are stored in the [MESSAGE] folder. If you don’t need them, delete them. You can
confirm the location of the [MESSAGE] folder by clicking on [Options] in the [Tools] menu before uninstalling.

Uninstalling Software
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....................................................................................................................................................
Note
You will be able to use Online Help after DSS Player is installed.

Using Online Help
For information on the DSS Player usage and features, refer to the Online Help.
To open Online Help, you have the following options.

Windows
• Click the [start] button, select [All Programs], then [Olympus DSS Player], then click [Help].
• While DSS Player is running, choose [Contents] from the [Help] menu.

• While DSS Player is running, press [F1] on the keyboard.

Macintosh
• While DSS Player is running, choose [DSS Player Help] from the [Help] menu.

Search by Contents

1 Once the Online Help screen appears, click
the Contents tab.

2 Double-click the  icon of the desired
topic heading.
The title of the topic is displayed.

3 Double-click the  icon of the desired topic.
An explanation of the topic is displayed.

Search by Key word

1 Once the Online Help screen appears, click
the Index tab.

2 Enter text.
Matching keywords are located automatically.

3 Choose a topic, then click [Display].
An explanation of the topic is displayed.
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Connection to Your PC

Connecting to your PC Using the USB
Cable

1 Turn ON the recorder (� P.12).

2 Insert end A of the USB cable to
your PC’s USB port or USB hub.

3 Make sure the recorder has
stopped before attaching end b
of the USB cable to the terminal
port of the recorder.
If “REMOTE” is displayed on the
recorder, it indicates proper
connections.

Once you connect the recorder to your PC, the recorder will
be powered through the USB cable. The batteries will not
be in use.

REMOTE
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Be sure to install the DSS Player software before connecting the recorder to a PC.
You can directly connect the recorder’s USB terminal to your PC.

Windows

Macintosh

When the recorder is connected and “My Computer” is
opened, a removable disk drive is displayed. If “Add New
Hardware Wizard” appears, cancel the wizard by pressing
the [Cancel] button and then install DSS Player.

If the recorder is connected to Mac OS, an icon with a drive
name of “Untitled” appears.
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Windows

1

Disconnecting from Your PC

1 Click the  on the task bar
located at the lower-right corner
of the screen. Click [Safely
Remove Hardware].
It will read [Stop USB Disk-Drive] for
Windows Me. The drive letter will differ
depending on the PC being used.

2 Disconnect the USB cable.
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1 Move the icon of the recorder's drive displayed on desktop to trash box by
drag and drop.

2 Disconnect the USB cable.

....................................................................................................................................................
Notes
• NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you

do, the data on the card will get destroyed.
• When the recorder is connected to a PC, the power will be supplied from the USB cable.
• Refer to the user’s manual for your PC regarding the USB port or USB hub on your PC.
• Be sure that you connect the USB cable either directly to the USB port on your PC or the self-power (AC

adapter connection) USB hub.
• Be sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.



52

4

R
u

n
n

in
g

 D
S

S
 P

layer

By connecting the recorder to your PC, you can automatically start the application.

Disabling automatic start

1 Right click on the  of the taskbar on the
lower right of the screen, and select [Setting].
The application which enables setting will be displayed
by dialog.

2 Click the  of the [DSS Player Version 6].
The check mark on [DSS Player Version 6] disappears.
For automatic start, select and click DSS Player to
reinstate again.

Windows

3

2

2

Running DSS Player

Manual start

1 Start Windows.

2 Click the [start] button, select [All
Programs], then [Olympus DSS
Player].

3 Click [Olympus DSS Player].

..............................................................................................................................................................

Note
You cannot run more than one DSS Player program or multiple copies of the same program simultaneously.

2
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Macintosh

....................................................................................................................................................
Note
The Mac version DSS Player has no automatic start function.

To start, open the “DSS Player” folder created upon installation and double-click the  icon.
When it starts for the first time after installation, user information needs to be registered.
Please see �P.46 for details.
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Window Names

1 Play Control Bar
Control buttons to play and stop voice files.

2 Dictation Folder Window
Will display the directory structure of the DSS,
WMA,  WAVE (Windows only) and AIFF
(Macintosh only)-format files stored on your
PC’s hard disk.

3 Device Manager Window
Will display the directory structure of the folders
in the recorder.

4 Voice File List Box
Will display the voice files in the folder selected
in 2 and 3.

* Main screen displayed when
DSS Player is started

Windows

Macintosh
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There are 3 download options to transfer voice files from the recorder to the PC:

• Download Selected Files
Download one or several voice files to your PC.

• Download Folders
Download all the voice files in one folder.

• Download All
Click the  icon and download all the voice files stored in the recorder to your PC.

The following is an explanation of “Download Selected Files”. For explanations of “Download
Folders” and “Download All”, refer to Online Help.

1 Select the folder.
From the Device Manager window, select the folder
that contains the voice file you would like to download.
The illustration shows that Folder A has been
selected.

2 Select the voice file.
Select the voice file you would like to download from
the Voice File List Box. To select more than one file,
hold either the [Ctrl] or [Shift] key and select files.
The illustration shows that one voice file is selected.

Download Voice Files from the Recorder

5         Managing Files on Your PC
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3 Download the voice file.
Windows

From the [Download] menu, click
[Download Selected Files].

Macintosh

From the [Tools] menu, click
[Download Selected Files].

4 Download complete.
Do not disconnect the USB cable while
the record/play indicator lamp on the
recorder is flashing. Disconnecting the
USB cable when the recorder lamp is
flashing wil l result in data loss or
corruption.

..............................................................................................................................................................

Notes
• NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If

you do, the data on the card will get destroyed.
• Depending on the size of the voice file and your PC, it may take some time to download the files.
• The downloaded files will be stored in the download tray folder that corresponds to the folder in the

recorder.
(Example: A voice file downloaded from Folder A will be stored in download tray A on your PC.)

• If a voice file already exists on your PC with the same name, date and time recorded, the new file will not
be downloaded.
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Download Voice Files from the Recorder
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Play a Voice File

1 Select the folder.
Select the folder that contains the voice
file you would like to play.

2 Select the voice file.
Select the voice file to play from the Voice
File List Box.

3 Play the voice file.
Click the  (play) button of the Play
Control Bar.
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Other playback control such as Rewind, Fast
Forward, Stop, Speed Control, Volume
Control, Time Axis and Index Skip are
available from the Play Control Bar.

Extension

File number ....... A serial number automatically assigned by a Digital Voice Recorder.

User ID ....... The name that has been set on the Digital Voice Recorder. The default name on the
Digital Voice Recorder is “DS23”. The user ID can be modified with DSS Player (� P.61).

File Name Format
File names are assigned in the following manner:

DS23 0001.DSS

3

1 2
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DSS Player has a feature to enable you to upload DSS-format voice files from your PC to the
recorder.

Upload Voice Files to the Recorder

1 Select the folder.
Select the folder that contains the voice
file to upload from the Dictation Folder
window.

2 Select the voice file.
Select the voice file to upload from the
Voice File List Box.

3 Select the folder to upload.
Windows

From the [Download] menu select
[Upload Files] or click the Upload icon.
Once the folder list box where the file is
to be uploaded is displayed, select the
folder from which the fi le is to be
uploaded.

Macintosh

From the [Tools] menu, click [Upload
Files].  Once the folder list box where the
file is to be uploaded is displayed, select
the folder from which the file is to be
uploaded.

4 Upload the voice file.
The voice file is uploaded to the recorder.
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5 Upload complete.
Once the transmission screen closes and the record/play indicator lamp on the recorder is
OFF, upload is completed.

You can also drag and drop files from the Voice File List Box to the Device Manager window.
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..............................................................................................................................................................

Notes
• NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If

you do, the data on the card will get destroyed.
• If a file with the same name exists in the folder of this recorder, it cannot be transferred.
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You can easily record on the PC directly using the recorder and the DSS Player. While the
recorder is connected to the PC with the USB cable, the Remote Dictation window in the DSS
Player allows you to create a new recording or edit an existing recording. The recorder will act
as a sophisticated microphone with the buttons controlling the recording or editing process.
See the Online Help for details (�P.49.)

Direct Recording/Editing on PC

.............................................................................................................................................................

Notes
• If you open the Remote Dictation window while the recorder is connected, the function of the recorder is changed to

Audio device from Storage device automatically. The recorder as AUDIO device is not displayed as a removable drive
on your PC. Closing the Remote Dictation window and returning to the main screen will switch the recorder back to
storage class device displayed as a removable drive.

• You cannot edit WAV files.
• The maximum recording time per file is 99 hours.
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Mac

Windows Macintosh

Editing existing files

1 From the DSS Player main window,
select the file you want to edit from
the Voice File List Box.

2 Click the [File] menu, then select
[Edit File], or click the  icon.
Remote Dictation window appears.

3 Edit the recording using the
recorder buttons.
You can use the mouse connected to your PC
and the Record and Playback controls to edit
recordings.

Recording a new file

1 From the DSS Player main window,
click the [File] menu, then select
[New File], or click the  icon.
Remote Dictation window appears.

2 Press the  (record) button in
the Remote Dictation window or
press the REC button on the
recorder to start recording.

3 Press the  (stop) button or
press the STOP button on the
recorder to stop recording.
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....................................................................................................................................................
Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.

21

Audio files are stored in the Message folder on the hard disk. If you want to send a voice file by
attaching it to E-mail, select the file from the Message folder.

The Message folder location can be found from the [Tools] menu, [Options], and then “Download
folder” tab.

The file can be replayed with DSS Player-Lite even though the recipient does not have DSS
Player. Free DSS Player-Lite can be downloaded from Olympus homepage.

http://www.olympusamerica.com/cpg_section/cpg_downloads.asp
http://olympus-europa.com/consumer/2590_software.cfm

Send Voice Files with E-mail

The user ID is used in file names that are recorded on a Digital Voice Recorder.

Changing User ID

1 Enter the user ID in the [Transfer User ID]
window.

Windows  From the [Download] menu.

Macintosh  From the [Tools] menu.

2 Click [Transfer].
The new user ID will be transferred to the Digital Voice
Recorder.
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Changing a folder name in the Voice Folder window
Windows

You can change a folder name using the [Rename Folder] command from the [Edit] menu.
A folder name can be up to 20 characters long and cannot use \ /:*?"<>|.

Macintosh

Choose the [Rename Folder] command from the [File] menu.

Changing a folder name in the Device window
Windows

Right-click the folder name to change, select the [Rename Folder] and input the new folder
name.

Macintosh

Choose the [Rename Folder] from the [File] menu and type a folder name.
The names of the folders on the Digital Voice Recorder is updated with the new folder names.
Device Window folder names consist of a string of 12 or fewer single-byte alphanumeric characters.

Changing a Folder Name

You can use a PC to create or edit file comments in DSS Player in the [Edit Comments] window,
and transfer them from the PC to the recorder. You can also edit file comments imported from
the recorder to a PC.

Choose the [Edit Comments] command from the [Tools] menu.
Files comments can use up to 100 alphanumerical characters and symbols.

Editing File Comments

..............................................................................................................................................................

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.

..............................................................................................................................................................

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.
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Windows

Macintosh

If this recorder is connected by USB, it
can function as a USB speaker. If the
recorder is used as a USB speaker, audio
output can be done through the recorder,
without audio output from the speaker
attached to the computer.
Select the [Select Audio Output] from the
[Tools] in the menu bar, and change the
output destination.

Uses as a USB Speaker

USB Microphone/USB Speaker
The recorder can be used as a USB speaker or microphone when connected to a PC. If you
use the recorder as a USB speaker, you can output voice through the recorder instead of using
the PC speaker. When used as a microphone, you can record voice on your PC using your
favorite application.

1 Click the  icon in the toolbar to change the recorder to Audio device.

1 From the [Tools] menu, select [Change to audio device].

U
S

B
 M

icro
p

h
o

n
e/U

S
B

 S
p

eaker



64

5

If this recorder is connected by USB, it can function as a USB microphone. Also, if an upgrade
(� P.65) is executed to the DSS Player Plus, voice recognition software or other applications
using this recorder as a microphone, voice can be input to a computer.

Windows 2000, Me

Select [Control Panel] = [(Sound and) Multimedia] = [Audio] tab, and select the [USB Audio
Device] from the recording device.

Windows XP

Select [Control Panel] = [Sound and Audio Device] =  [Audio] tab, and select the [Microphone
Control (DVR)] from the recording device.

Uses as a USB microphone

....................................................................................................................................................

Notes
• If you switch the recorder to Audio device, the recorder does not function as Storage device, and it is not

displayed as a removable drive.
• Changing the USB speaker can be executed from the [Control Panel] as well as the USB microphone.
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USB Microphone/USB Speaker



65

5

Upgrade Function

The “DSS Player” enables upgrades (Options) to the “DSS Player Plus” which is equipped with
more functions. In addition to the DSS Player functions, voice recognition using voice recognition
software, joining of files, sharing of files and the menu setting of this recorder can be utilized.

Purchase and Upgrade
To purchase “DSS Player Plus” and upgrading from “DSS Player” is operated in the following
procedures.
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Windows Macintosh

1 Start the DSS Player.
Please see � P.52 for the starting method.

2 Click the  button or select [Purchase
a new license for DSS Player Plus] in
the [Help] menu.
The web browser will start and the purchase
site of the DSS Player Plus will be displayed.
Please operate according to guidance on the
screen.
When the purchase procedure is completed, the
license number will be issued by mail.

2
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3 Select [Upgrade to DSS Player Plus]
from the [Help] menu.
The “Upgrade to DSS Player Plus” dialog will
be displayed.

4 In the [Upgrade to DSS Player Plus]
dialog, enter the license number of your
purchase, and click the [OK] button.
When starting the application next time, DSS
Player will be upgraded to DSS Player Plus.

Upgrading to DSS Player Plus

When upgraded, the title of the main menu changes to [DSS Player Plus]. Also, you can confirm
the upgrade by selecting [About DSS Player] from the [Help] menu on the tool bar. In the
[About DSS Player] window, the [DSS Player Plus] should be displayed.
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....................................................................................................................................................

Notes
• To purchase the license number, it requires an environment where the Internet can be utilized.
• Please see the details in the website regarding the purchase of the license number.

3

Upgrade Function
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IBM Corp.
• IBM ViaVoice Pro USB Edition 10
ScanSoft, Inc.
• Dragon NaturallySpeaking 8

Please inquire to the Olympus Service Center regarding the situation for software to be released
hereafter (� P.85).
Also, when you use such software in combination with this recorder, please confirm the software
operation with the user’s computer and the maker.

• Please contact IBM for support information on  the voice recognition software, ViaVoice.
• Please contact ScanSoft for support information on ScanSoft Dragon NaturallySpeaking.

Plus Using Voice Recognition Software
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....................................................................................................................................................

Note
Voice recognition can only be used with Windows.

In conjunction with “ViaVoice” of IBM Corp. or “Dragon NaturallySpeaking” of ScanSoft Inc.
which are on the market, the files recorded in this recorder can be transferred to a computer
and converted to text. Please see the instruction manual for the voice recognition software for
details.

The voice recognition software which is confirmed for use with this recorder is as follows. (As
of February, 2005)
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Using Voice Recognition Software

1 Connect the recorder to your PC, and start the DSS Player Plus.

2 Click the [start] button, select [All Programs], then select [IBM ViaVoice
VoiceCenter].

When the DSS Player Plus and IBM’s voice recognition software “ViaVoice” are used together,
execute the setting in the following procedure to record the voice accurately, acquired from the
built-in microphone or speaker.

Voice Recognition in ViaVoice (Audio set up)
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3 From the IBM [ViaVoice
VoiceCenter], select [ViaVoice],
[Tools], then [Analyze My Voice].
The ViaVoice User Wizard window
appears.

4 From the [Device] list box, select
[Olympus DSS File] or [Olympus
WMA File].
Select [Olympus DSS File] or [Olympus
WMA File] in the [Device] list box, then
click the [Next] button.

5 Click the [Next] button.
The [Audio Setup Wizard] window
appears.
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6 Select a sound card.
When the [Selecting a Sound Card] window
appears, select [USB Audio Device] for [Input]
and follow the instructions on screen. (Select
[Microphone Control (DVR)] for Windows XP.)

7 Proceed with the AUDIO Setup
according to the instruction on screen.
During audio setup, enrollment, please input
voice data from the recorder.

It is recommended that you enroll while in your normal surrounding environment settings.
This will help improve the voice recognition by registering your voice characteristics and your
environment.
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Using Voice Recognition Software

When the DSS Player Plus and ScanSoft’s “Dragon NaturallySpeaking 8” are used together,
create the user in “Dragon NaturallySpeaking 8” in advance. It is necessary to execute the
training.  By executing it, the features of your voice will be registered, and the rate of recognition
will improve.  Please advance the setting according to the following procedures.

Voice Recognition in Dragon NaturallySpeaking (Training)

1 Startup Dragon NaturallySpeaking 8.
Click the [start] button, select in the order of [All Programs] = [Dragon NaturallySpeaking 8] =
[Dragon NaturallySpeaking 8].
* If the DSS Player Plus has started, please close it in advance.

2 [New User Wizard] will be displayed.
* If the user is already registered in Dragon

NaturallySpeaking 8, the [Open User] dialog will
be displayed.  In this case, click the [New] button
and display [New User Wizard].

3 Creating a User.
Input a name into [Your name], and select
[Olympus IC Recorder DS-2300] from the
[Dictation source] list box, then click the
[Next] button.

4 Description of Wizard.
Description of this wizard will be displayed.
Click the [Next] button.
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5 Recording Training Text.
Follow the instructions on the screen, and record the training text to this recorder.  At this
time, record with “SP” for the recording mode, and “DICT” for the microphone sensitivity.
Please refer to “Notes on Recording For Voice Recognition”(�P.74) for recording tips.  After
the recording is finished, click the [Next] button.

6 Transferring the Recorded Voice.
Click [Olympus DSS Player] button
displayed on the screen.  The DSS Player
Plus will startup and then follow the
instructions displayed on the screen to
execute the transfer of the recorded voice.
After finishing, click the [Next] button.

7 Adding a User.
Click the  button displayed on the screen.
After this operation is finished, follow the
instructions on the screen, then complete
the registration for a new user.
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Using Voice Recognition Software

DSS Player Plus can easily access ViaVoice and Dragon NaturallySpeaking 8 from the menu,
and it enables text conversion of the file in the Voice File List Box.

1 Select the folder.
From the Dictation Folder Window, select
the folder in which the file to be converted
to text is stored.

2 Select the voice file.
From the Voice File List Box, select the
file to be converted to text.

3 Start of voice recognition.
Clicking the arrow at the right side of the
voice recognition icon  displays the voice
recognition software. Select and click
ViaVoice or Dragon NaturallySpeaking as
the software to be used.

Executing Voice Recognition
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When Dragon NaturallySpeaking is Selected

The [Open User] dialog will be displayed, and select
the user created in procedure 3 on P.70, then click
the [Open] button.  The [Transcription Options]
dialog will be displayed, and select the option
according to the purpose, then click the [Transcribe]
button.

The text conversion will start.  However, if the voice
recognition software is not installed, the voice
recognition software start icon  becomes an
invalid display.

Noise Canceling Function

Check [Use Noise Cancellation] in the [Voice
Recognition] menu to output voice using the noise
canceling function to the voice recognition software.
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....................................................................................................................................................

Note
The voice recognition of the file recorded in LP mode cannot be recognized.
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Notes on Recording For Voice Recognition

When recording voice to be processed
with voice recognition, set up your
DSS recorder as follows to improve
recognition accuracy.

• Set the microphone sensitivity to “DICT”
(� P.22).

• Set the recording mode to “SP” (� P.23).
• Set the Variable Control Voice Actuator

(VCVA) to “OFF” (� P.24).
• Register/enroll your voice in the voice

recognition software using the recorder.
• Record in a relatively quiet environment.
• Have the recorder microphone 5 to 10

cm (2 to 4 inches) away from your chin.

The file recorded in the next condition,
will be a low rate of recognition, which
can not be used for voice recognition.

• A conference or meeting where many
voices are recorded.

• Seminar or lecture where high-level
ambient noise tends to be recorded.

• Speak normally.
• It is recommended to use the noise-

cancellation microphone ME12, when
recording.
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Using Voice Recognition Software
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In DSS Player Plus, designated multiple voice files can be joined and one voice file can be
created.

1 Select the folder.
From the Dictation Folder Window, select
the folder which contains the files to be
joined.

2 Select the voice files.
From the Voice File List Box, select more
than one file to be joined.

3 Select  [Join]  from the [Edit]  menu
or press the  button.
The dialog to join files will be displayed,
listing the files selected in step 2.

Joining FilesPlus

3

21



76

5

4 Set the order of files.
After  joined, the playback order of the files
can be changed. Select a file, and move the
file to its appropriate position in the order
using the [Up] and [Down] buttons.

5 Input File Names.
The file name is created automatically after
joining and also, it enables input optionally.

6 Press the [Join] button.
The resulting file is saved under the name
specified in step 5, and stored in the
selected folder.

....................................................................................................................................................

Note
If the files to be joined have different recording modes, the mode of the file listed at the top is selected.
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Joining Files
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One designated voice file can be split into the two files in DSS Player Plus.

1 Select the folder.
Select the folder containing the file to be split
from the Dictation Folder Window.

2 Select the voice files.
Select one file to split from the Voice File List
Box.

3 Select [Split] from the [Edit] menu or
press the  button.
The setting dialog of the file to be split will be
displayed.

Splitting FilesPlus

3
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4 Set the split position.
Press the  button to playback the file, and press the  button in the position to be
divided.
Also, the playback slider position in the time axis shows the current playback position, and
also shows the split position (slide the playback slider to the right or left, which enables
moving to the position to be split).

5 Input File Names.
The file name is created automatically after splitting and also, it enables input optionally.

6 Press the [Split] button.
The splitting of the file will complete, and the file name designated in procedure 5 will be
saved.
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 Playback /
 Stop button

The display will
change whenever the
button is pressed.

Split position
(Time axis)

Playback slider
Shows the current playback position
and split position.

6
4

5
Input file name
(File name before
splitting.)

Output file name
(File name after
splitting.)

Splitting Files
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The menu setting of this recorder can be changed in the “Configure recorder menu” screen in
the computer.

Menu Setting of this Recorder

1 Select [Configure recorder menu]
from the [Download] menu.
The “Configure recorder menu” dialog will
be displayed.

2 Execute Menu Setting.
Click the radio button to be changed,
and input a check.

3 Press the [OK] button.
The set contents will be transferred to
this recorder.
After the finishing, the menu setting of
this recorder wil l be changed by
removing the USB connection of this
recorder from the computer.

Plus

3

1
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Using the Recorder as a Reader/Writer

When the recorder is connected to your PC, it will be recognized on your PC as a removable
drive. You can view and access the recorder card from My Computer and download data from
the card to your PC using standard windows copy/move and delete commands. You can also
upload data from the PC to the card in the recorder in the same way.

Example: Copying Data from PC to Card Using Explorer or
Finder
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6 Other Practical Use Methods

1 Start Windows.

2 Connecting the recorder to your PC.
For connection procedure, refer to “Connecting to Your PC Using the USB Cable” (� P.50).

3 Open Windows Explorer or Finder window.
The recorder will appear as a removable drive icon.

4 Copy data to card.
While the data are being written or copied, the record/play indicator lamp on the recorder
will flash.

.............................................................................................................................................................

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.



81

7

A
larm

 M
essag

e L
ist

Alarm Message List

Meaning
Low battery
power

Erase-locked

Index full

Folder full

Maximum
number

Incompatible
card

Zero remaining
memory

Formatting
error

No card

Card cover is
opened

System error

Action
Replace with new batteries (� P.11).

Unlock the file (� P.31).

Erase index marks that are no
longer required (� P.32).

Erase unnecessary files (� P.29).

Erase unnecessary files (� P.29).

Insert a compatible card.

Erase files that are no longer
required or insert another card.

Reformat the card (� P.35).

Insert a card (� P.16).

Close the card cover securely until it
click (� P.16).

This is a malfunction. Contact the
place of purchase or Olympus
Service Center for repair.

Explanation
Battery power is getting low.

Tried to delete a locked file.

The file is full of index marks
(maximum of 16 marks).

The folder is full of files
(maximum of 199 files).

The destination folder
already has the maximum
number of files (199).

An incompatible card was
inserted.

The card has no remaining
memory.

There was an error while
formatting the card.

There is no card inserted.

The card cover is not closed.

System error detected in the
recorder.

7 Other Information

Message
BATTERY LOW

FILE
IS LOCKED

INDEX FULL

FOLDER FULL

MEMORY
ERROR

MEMORY FULL

FORMAT
ERROR

INSERT CARD

CARD  COVER
IS OPEN

SYSTEM
ERROR
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Troubleshooting

Symptom
Nothing appears

on the display

Won’t start

Unable to
record

No playback
tone heard

Unable to erase

Noise heard
during playback

Recording level
too low

Unable to set
index marks

Cannot find the
recorded voice

Cannot connect
to PC

Probable cause
The batteries are not loaded properly.

The batteries are dead.

The recorder is in power off mode.

The recorder is in power off mode.

The batteries are dead.

The card does not have enough memory.

The card is unformatted.

The maximum number of files has been
reached.

The earphone is connected.

The VOLUME button is set to 0.

The file is locked.

The recorder was shaken during
recording.

The recorder was placed near a cell
phone or fluorescent lamp while
recording or during playback.

The microphone sensitivity is too low.

The maximum number of index marks
(16) has been reached.

The file is locked.

Wrong folder.

Sometimes a connection cannot be made
with some PCs running Windows XP.

Action
Verify polarity is correct (� P.11).

Replace with new batteries (� P.11).

Turn the recorder ON (� P.12).

Turn the recorder ON (� P.12).

Replace with new batteries (� P.11).

Erase unnecessary files or insert
another card (� P.16, 29).

Format the card (� P.35).

Check another folder.

Unplug the earphones to use the internal
speaker.

Adjust the VOLUME button.

Unlock the file (� P.31).

Move the recorder.

Set the microphone sensitivity to CONF
mode and try again (� P.22).

Erase unnecessary index marks
(� P.29).

Unlock the file (� P.31).

Switch to the right folder.

You need to change the PC’s USB
settings. See DSS Player online help for
details (� P.49).



83

7

Accessories (optional)
A
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PC Transcription kit : AS-2300
The AS-2300 transcription kit provides you with a PC-footswitch, a headset and DSS Player
software for easy transcription of DSS recordings.

xD-Picture Cards of 16, 32, 64, 128, 256 and 512 MB: M-XD16/32/64/128/256/512
Olympus CAMEDIA digital camera series xD-Picture Cards can be used.

Headset: E102
Stereo headset for your PC. A helpful tool for PC based transcription.

Monaural binaural earphone: E20

Noise-Cancellation monaural microphone: ME12
(Dictation microphone)
Used to get crisp recordings of your own voice by reducing the effects of ambient noise.
This is useful microphone and suits for voice recognition.

External microphone: ME15
A lavalier omnidirectional microphone that clips to clothing. Used to record your own voice or
people near you.

Ni-MH Rechargeable Battery Charger: BU-400 (Europe only)
Charger for AA batteries (1 to 4) or 1 to 2 AAA batteries.

Ni-MH Rechargeable Battery: BR401
High-efficiency rechargeable long life batteries.

Connecting cord: KA333
Use to connect the microphone jack of this unit to a radio or other sound source.

Plug adapter: PA3
A mini plug adapter to connect 2.5 mm mini-plug devices such as microphone to the recorder
3.5 mm mini-jack.

USB Reader/Writer: MAUSB-10 (Dual-Slot xD-Picture Card & SmartMedia)
Allows data to be transferred to and from a PC.

USB Reader/Writer: MAUSB-300 (xD-Picture Card)
Allows data to be transferred to and from a PC.

PC Card adapter: MAPC-10 (xD-Picture Card/SmartMedia)
Allows data to be transferred to and from a PC that has a PC card slot.
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Specifications
Recording format

DSS (Digital Speech Standard)

Input level
–70 dBv

Sampling frequency
SP mode: 12 kHz
LP mode:  8 kHz

Overall frequency response
SP mode: 300 to 5,000 Hz
LP mode: 300 to 3,000 Hz

Recording time (16MB Card)
SP mode: 2 hours 30 minutes
LP mode: 5 hours 30 minutes

Alkaline battery life
Recording:

Approx.20 hours
Playback:

Approx.12 hours

Ni-MH Rechargeable Battery (BR-401) life
Recording:

Approx.15 hours
Playback:

Approx.10 hours

Speaker
Built-in ø28 mm round dynamic speaker

MIC jack
ø3.5 mm mini-jack, impedance 2kΩ or more

EAR jack
ø3.5 mm mini-jack, impedance 8Ω or
more

Maximum working output (3 V DC)
220 mW or more (8 Ω speaker)

Input power requirement
Rated voltage: 3 V
Batteries: Two AAA  batteries (LR03 or

R03) or
Two Ni-MH rechargeable
batteries (BR-401)

External dimensions
110.2 x 50.0 x 17.2 mm
(without protrusions)

Weight
101 g (including alkaline batteries)

* Specifications and design are subject to change
without notice.

* Battery life is measured by Olympus. It varies
greatly according to the type of batteries used
and the conditions of use.
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Technical Assistance and Support
The following are contact information for technical support for Olympus recorders and software
only.

� Technical Hotline Number in the U.S. and Canada
1-888-553-4448

� User Support E-mail address in the U.S. and Canada
distec@olympus.com

� Technical Hotline Number in Europe
Toll free number
00800 67 10 83 00

available for Austria, Belgium, Denmark, Finland, France, Germany, Italy, Luxemburg,
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, United Kingdom

Charged numbers for the Rest of Europe
+49 180 567 1083
+49 40 23773 899

� User Support E-mail address in Europe
dss.support@olympus-europa.com

Tech
n

ical A
ssistan

ce an
d

 S
u

p
p

o
rt



P2-BZ8090-01
AP0503

Declaration of Conformity
Model Number: DS-2300
Trade Name: DIGITAL VOICE RECORDER
Responsible Party: OLYMPUS IMAGING AMERICA INC.
Address: 2 Corporate Center Drive, PO BOX 9058 Melville, NY 11747-9058, U.S.A.
Telephone Number: 800-622-6372

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
Canadian RFI
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the Radio Interference Regulations of the Canadian Department of Communications.

Cet appareil numérique ne dépasse pas les limites de Catégorie B pour les émissions de bruit radio émanant
d’appareils numériques, tel que prévu dans les Règlements sur l’Interférence Radio du Département
Canadien des Communications.

“CE” mark indicates that this product complies with the European requirements for safety, health,
environment and customer protection.

Shinjuku Monolith, 3-1 Nishi-Shinjuku 2-chome, Shinjuku-ku, Tokyo 163-0914, Japan. Tel. 03-3340-2111

Two Corporate Center Drive, PO BOX 9058 Melville, NY 11747-9058, U.S.A. Tel. 1-800-622-6372

(Premises/Goods delivery) Wendenstrasse 14-18, 20097 Hamburg, Germany. Tel. 040-237730
(Letters) Postfach 10 49 08. 20034 Hamburg. Germany.

2-8 Honduras Street, London EC1Y OTX, United Kingdom, Tel. 020-7253-2772
http://www.olympus.com

This symbol [crossed-out wheeled bin WEEE Annex IV] indicates separate collection of waste electrical and
electronic equipment in the EU countries.
Please do not throw the equipment into the domestic refuse.
Please use the return and collection systems available in your country for the disposal of this product.

For customers in North and South America

For customers in Europe


